Guide to Referencing with Mendeley for the AR6 WGI Report

Key points

Setting up Mendeley

- If you don’t already have one you will need to set up a Mendeley account – we recommend using the email address you use for IPCC correspondence.
- **Only store references in your chapter’s Mendeley group** (the TSU has already created this group for you and will send you an invitation to gain access). Do not cite references in your Word draft that are stored elsewhere or create folders within your chapter’s Mendeley group.

Adding references

- **Add references to Mendeley by downloading and importing reference files** (use BibTeX files, .bib, if available or RIS files, .ris, if not) or by using a direct import to Mendeley option on a webpage (where available). **Please avoid using the Mendeley browser plugin for importing references as it frequently imports incorrect reference details.**
- Check if references are already present in your chapter’s Mendeley group before adding them to avoid creating duplicates.
- It is good practice to add your initials + surname in the Tags field for the Mendeley entries when adding references to your Mendeley group (e.g., ‘jmsmith’ for J.M. Smith)
- **Do not store PDFs in your chapter’s Mendeley group as it has limited storage.**
- **Sync often when using Mendeley Desktop** by clicking the Sync button. This will keep the cloud version of the group up-to-date.
- If you find Word becomes slow when adding or editing in-text citations, try working on the citations individually in a blank Word document. Citations created with the Mendeley Word plugin can be copied and pasted between Word documents.
- If you do a refresh with the Mendeley Word plugin (which will re-sync the details of the Word citations to match those of the Mendeley group) and one or more popups appear asking if you want to keep a manual citation edit, you should select ‘**Keep Manual Edit**’.
Assistance

- It is strongly recommended that each chapter recruits a Chapter Scientist who, among other responsibilities, can do quality control on referencing. For instance, they can ensure all references cited in the chapter’s Word draft have been linked to Mendeley.
- Contact the WGI TSU at wg1tsu@ipcc-wg1.fr with any questions on Mendeley or referencing in general.

Table of Contents

Introduction ........................................................................................................................................... 3
General handling of chapter references ................................................................................................. 4
Registering for a Mendeley account ....................................................................................................... 4
Joining your chapter’s Mendeley group ................................................................................................. 5
Software installation ............................................................................................................................. 6
Optional software .................................................................................................................................. 6
  Mendeley for Android ....................................................................................................................... 6
  Mendeley for iOS .............................................................................................................................. 7
Using the Mendeley interfaces .............................................................................................................. 7
Mendeley Desktop .................................................................................................................................. 7
  Adding references ........................................................................................................................... 9
  IPCC reference types ...................................................................................................................... 9
  Required and optional fields ............................................................................................................ 10
  Unpublished references .................................................................................................................. 12
  Foreign language works .................................................................................................................. 13
Mendeley Citation Plugin for Word ....................................................................................................... 17
  Inserting in-text citations .............................................................................................................. 18
  Adding or removing citations in a citation field ......................................................................... 19
  Manually editing citations ............................................................................................................. 20
  Merging a citation ......................................................................................................................... 22
  Unlinked citations .......................................................................................................................... 22
  Refreshing the Word citations ....................................................................................................... 22
Introduction

Mendeley will be used for referencing for the drafting of the Working Group I Contribution to the Sixth Assessment Report (AR6 WGI). This guide, written by the WGI Technical Support Unit (TSU), introduces Mendeley in the context of writing an IPCC report, building upon the experience of using Mendeley for the drafting of the Special Report on Global Warming of 1.5°C (SR1.5).

Mendeley is an integrated suite of software for managing, citing and sharing references. It takes its name from Biologist Gregor Mendel and Chemist Dmitri Mendeleev. The Mendeley ‘universe’ includes a web interface (Mendeley Web), Desktop applications for Windows and Mac, and apps for Android and iOS mobile phones and tablets. There is also a citation plugin for Microsoft Word (Windows and Mac) and a reference import browser plugin for Chrome, Firefox, Safari and Internet Explorer (Mendeley Web Importer). All interfaces can be downloaded and used for free. **We strongly recommend not to use the browser plugin as it frequently imports incorrect reference details.**

This guide covers the usage of these various Mendeley interfaces in the context of preparing the AR6 WGI report. We outline how to use Mendeley in combination with Microsoft Word to produce the chapter drafts. Although this guide should provide everything you need to know about Mendeley as an author or chapter scientist for the AR6 WGI report, additional information can be found in Mendeley’s [online help guides](#).

Mendeley will be used for the following tasks in the preparation of the chapter drafts:

1) To store the details of the references cited in each chapter. **The references will be stored in private Mendeley groups - one per chapter.**
2) To add citations in the Word draft (i.e. in-text citations) for each chapter.
*To create these citations the corresponding references must already be present in the respective chapter group on Mendeley.*

3) For the creation of the bibliography for each chapter.

**General handling of chapter references**

In IPCC reports (other than the Synthesis Report which does not have references), a separate reference list (or bibliography) is generated for each chapter. When citing literature in a Word draft, first add the corresponding references to your chapter’s Mendeley group (if not already present there) and then use the Mendeley Word plugin to generate the citations in the draft.

One person from each chapter should assume overall responsibility for quality control of the references. With assistance from the TSU, it is their responsibility to ensure that all the references cited in their chapter’s Word draft have been linked to Mendeley and have the correct details (e.g., year, journal title), as well as to generate the bibliography for the chapter. This role is typically performed by the Chapter Scientist (when a chapter has one). Note that prior to each review period, the TSU requires each chapter to submit a complete draft of their chapter in a single Word file, containing all text, figures and tables, and a bibliography at the end.

This guide proceeds by first explaining how to set up a Mendeley account and install the various Mendeley interfaces, and then how to use these interfaces in the drafting of the AR6 WGI report.

**Registering for a Mendeley account**

Before installing any Mendeley interfaces you should first set up a Mendeley account (if you do not already have one). To do this go to mendeley.com, click on ‘Create account’ in the top right-hand corner and then register with an email address. We recommend you sign up with the email you use for IPCC correspondence (the one we have on file for you) as we will be sending the invitation to join your chapter’s Mendeley group to this address. Please contact the TSU if you want to use a different email with Mendeley.
You will then be sent an email asking you to confirm your email address (which you should do).

Sign up form for a Mendeley account.

Joining your chapter’s Mendeley group

The WGI TSU has set up a private group on Mendeley for each chapter (e.g., ‘WGI Chapter 1’). Private groups are not listed on the Mendeley website and can only be joined by invitation. As previously mentioned, you will receive an email (at the address we have on file for you) inviting you to join the group for your chapter. You can accept this invitation by signing into Mendeley Web and going to the Groups page (by clicking on Groups in the top navigation bar). You will find the invitation under ‘My Invitations’.

The Groups page with an invitation to join the ‘WGI Chapter X’ group. Click ‘Accept’ to join.
Software installation

At a minimum, you should install the following Mendeley interfaces:

1) **Mendeley Desktop** (Download pages: [Windows](#), [Mac](#))

2) **Mendeley Citation Plugin for Word**
   This is installed from within Mendeley Desktop by selecting ‘Tools > Install MS Word Plugin’. You can also install it from a popup that appears the first time you open Mendeley Desktop after installing it, asking if you want to install the plugin.

Optional software

You may also wish to install Mendeley’s Android or iOS apps on your mobile phone or tablet (e.g., iPad). Note, however, that these have reduced functionality compared to the Desktop version. We do not provide detailed guidance on these interfaces here as they are similar to Mendeley Desktop and Mendeley Web Library, discussed later in this guide. We instead refer those wishing to use these apps to their official guides: [Mendeley for Android guide](#), [Mendeley for iOS guide](#).

**Mendeley for Android**

Mendeley for Android can be found by searching for ‘Mendeley’ on the Google Play Store. We recommend you turn off ‘Sync all files’ in the Settings menu to prevent any PDFs stored on the cloud from automatically downloading to your device. Note that the app will still sync references each time it is opened with this option turned off. You can also force a sync at any time by pressing the Sync button (arrows in a circle).
Mendeley for iOS

Mendeley for iOS can be found by searching for ‘Mendeley’ on the App store. As with Mendeley for Android, we recommend you turn off ‘Sync all files’ in the Settings menu.

Using the Mendeley interfaces

This section provides information on how to use Mendeley Desktop and the Mendeley Citation Plugin for Word in combination to draft the AR6 WGI report. Guidance is also provided on the use of Mendeley Web, although other than to join your chapter’s shared group, there is no need to use this interface.

Mendeley Desktop

We recommend using the Desktop application as your primary means of adding and editing references as it is the most feature-rich of Mendeley’s citation management interfaces (the others being Mendeley Web Library and the Android/iOS apps). The 11 key functions are in the context of writing an IPCC report are:

[Image: The layout of Mendeley Desktop.]
1. Add references – Use the button and adjacent dropdown to create reference entries from reference files or PDFs stored on your local machine. You can also do this by drag-and-dropping reference files and PDFs onto the Documents tab.

2. Folder management buttons – For adding or removing folders.

3. Sync – To sync between your local machine and the Mendeley cloud, where both your personal references (those in ‘My Library’) and your shared group references (those in ‘Groups’) are stored. Your personal library is not publicly accessible on Mendeley Web, nor are the references in or the member list for your chapter group (as it is a private group). Sync frequently to keep the cloud version up-to-date.

4. Search – Use this box to search within the references in the currently selected group or folder.

5. Literature search – This feature allows you to search for publications in Mendeley’s crowd-sourced catalogue. Avoid using this feature to add references as the imported references can sometimes contain errors.

6. My Library – Your personal library. By clicking on ‘All Documents’ you can view all the references it contains. If you have references that haven’t been assigned to a specific folder, they will appear under ‘Unsorted’. This folder only appears if you have such references.

7. Groups – Your group library. The shared group for your chapter (e.g., ‘WGI Chapter 1’) will appear here once you are a member. To view the references in a group, select the group in the left-hand panel and then click on the ‘Documents’ tab in the central panel. You can drag and drop references between your personal library and groups. Do not create folders within your chapter’s Mendeley group. Instead, store all references directly within the top-level of the group. If you delete a reference from a group or My Library, it will be sent to the Trash (i.e., the ‘All Deleted Documents’ folder).

8. Documents tab – This tab shows the contents of the group or folder that has been selected in the left-hand panel. By clicking on a reference, you will be able to view its details in the Details panel (#9). References with associated PDFs have a PDF file symbol in the File column of the central panel. Clicking on this symbol will open the PDF in Mendeley’s PDF viewer, where you can annotate the file (see the official guide to Mendeley Desktop for information). You can store PDF’s in
your personal library but please do not store them in your chapter’s Mendeley group (there is limited storage space).

9. **Details panel** – You can view and modify the details of references selected in the central panel here. If this panel is hidden you can open it by clicking on the small arrow on the far right of the screen. **You can use ‘Ctrl+z’ and ‘Ctrl+y’ to undo and redo changes made in the Details panel.**

10. **Trash** – Deleted references will appear here. You can restore them or permanently delete them.

11. **Filter pane** – Use this pane to filter the references in the currently selected folder or group. You can filter by author keywords, author name, assigned tags or publication title (i.e., journal name etc.).

**Adding references**

There are a variety of ways of creating reference entries in Mendeley. **Wherever possible we please add references using reference files or by a ‘direct import’ option on a webpage.** Methods that involve scanning of webpages or PDFs for reference details (i.e., the browser plugin and import of PDFs to Mendeley Desktop or Web Library) frequently produce incorrect reference details. For reports and working papers, often an indication of how the document should be cited is provided, so please search for these and enter the reference details in Mendeley accordingly.

**IPCC reference types**

To facilitate the creation of the bibliographies for each chapter in the IPCC style, the TSU has defined a set of IPCC reference types (see the Annex). Both journal and non-journal types (e.g., chapter in edited book) have been assigned, with the latter being given a reference type code or rt code of the form ‘rt#’ (e.g., ‘rt6’). The journal types do not have an rt code but some have a tag (see Unpublished references below). The TSU will insert the appropriate rt codes into the ‘Tags’ and ‘Translators’ fields of non-journal references appearing in the AR6 WGI Mendeley groups. Please do not remove them. We anticipate that the vast majority of references cited in the AR6 WGI report will be journal articles such that few references will need an rt code.

Each IPCC type has been paired with a Mendeley reference type (Mendeley does not have the capability of creating new reference types; see the Annex for the pairings). For a reference of a given IPCC type (e.g., rt14: chapter in unedited book or report), the
corresponding Mendeley reference type (‘Book Section’ for rt14) should be used in the Tags dropdown in the Details panel.

**Required and optional fields**

A set of required and optional fields has been defined for each IPCC reference type (see the Annex). The Mendeley entries for references cited in Word drafts must contain information for all the required fields for their IPCC reference type. The optional fields should also be completed where available, for example, **DOI’s should be provided for journal articles wherever possible**. URLs should be provided where available for other IPCC types and for journal articles where there is no DOI. All cited reference entries should have author(s) and/or editor(s), and titles. Published works and those in press (i.e., accepted but not yet published) also require a year. In place of a year, works that are in preparation (‘in prep’) and submitted journal articles will be indicated as ‘in prep’ and ‘submitted’, respectively, in both the bibliography and in-text citations (see Unpublished references below for instructions).

For some of the IPCC reference types, the default list of fields displayed in the Details panel for the corresponding Mendeley reference type in Mendeley Desktop does not include one or more of the required or optional fields. For example, the Series field is not shown by default for Mendeley’s ‘Report’ type. You can change the fields shown for each Mendeley reference type by going to ‘Tools > Options > Document Details’.

Modifying the fields that are shown in the Details panel for Mendeley’s ‘Report’ reference type. Note that you cannot change the fields at the top for which the tick boxes are filled black.
Instructions for individual fields

Authors and Editors fields: These fields expect input of the form ‘Firstname Surname’, ‘Initials Surname’, ‘Surname, Firstname’ or ‘Surname, Initials’. In the first two cases, Mendeley will convert the format to that of the latter two, respectively (i.e. reverse the first name and surname/initials and add a comma between them). Institutional names should be entered in abbreviated form in the Authors field, where these are defined (e.g., ‘IPCC’ instead of ‘Intergovernmental Panel on Climate Change’). In other cases, if the institutional name consists of two or more words, it will be necessary to override the aforementioned firstname/surname reversal behaviour. To keep the name as it was entered, select the first option in the dropdown that appears beneath the Authors field (it will read ‘[What you entered] (Institution/Organization)’).

Tags: Notes and codes can be stored in the Tags field (and filtered by these using the filter panel, #10). Multiple tags can be stored by using a semi-colon to separate each. The TSU will assign unique identifiers to each reference (of the form ‘[letter][number]’), placing these in both the Tags and Translators fields. In addition, the TSU will also enter IPCC reference type codes of the form ‘rt#’ in these two fields, indicating which IPCC reference type it is (see the Annex for further information). Please do not remove these identifiers or codes.

We recommend that authors add their initials + surname as a tag in the Tags fields (e.g., ‘jmsmith’ for John M. Smith) when they add references. This will enable the TSU and Chapter Scientists to know who to contact in case of issues with individual references.

Pages: The pages field can contain either page ranges (e.g., 5-10), or page counts (e.g., 50). Page ranges should appear without spaces (e.g., ‘35-38’). Consult the Annex for the IPCC reference types that have entries in this field and the type of entry (range or count) needed. Page ranges are used with the reference types that relate to articles or chapters within a larger volume (journal articles, book or report chapters, in proceedings etc.).

Location: Countries should be entered in the City field after the City name (e.g., London, UK). The Country field should not be used. Abbreviations should be used for American States (e.g., NY for New York) and Canadian Provinces, along with the United Kingdom and United States (‘UK’ and ‘USA’, respectively). In cases where there are multiple organizations (and thus multiple locations), the City field should not be used. Instead the organization names and their locations should be entered in the Publisher field in the form in which they are expected to appear in the bibliography (e.g., ‘Organization A, City, Country and Organization B, City, Country’).

Publisher: The publisher field should be used to list the institution(s) responsible for the publication of the work, as well as those responsible for its content, if different.
Publishers and Institutions can be written together in the field as ‘Publisher. Institution’. The institution field should not be used.

Series: This field can be used for report and working paper numbers as well as the names of book series.

DOIs: DOI codes should be entered in lowercase and without ‘dx.doi.org’ or any similar prefix.

URLS: URLs should be provided whenever available, particularly for reference types other than journal articles (only a DOI is required for Journal articles). URLs should be a link to the publishers’ website, where the work can be downloaded (if accessible).

Date accessed: Web pages should be given a date accessed entered in the form ‘YYYY-MM-DD’ (dashes included). The Mendeley browser plugin (use of which is generally not recommended) will automatically complete this field with the current date when used to create a reference for webpage.

**Unpublished references**

To keep track of references that have not yet been formally published, the appropriate tag from among the following should be added (brackets included) to both Tags and Volume fields:

<table>
<thead>
<tr>
<th>Type of reference</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>In preparation – i.e. not yet submitted or accepted/finalized</td>
<td>(in prep)</td>
</tr>
<tr>
<td>Submitted for peer review (only applies to journal articles)</td>
<td>(submitted)</td>
</tr>
<tr>
<td>Accepted or finalized but not yet published</td>
<td>(in press)</td>
</tr>
</tbody>
</table>

It is recommended that unpublished works be excluded from the crowd-sourced Mendeley catalogue. This can be achieved by clicking the Unpublished work box at the bottom of the Details panel.

**Other Settings**

- Unpublished work - exclude from Mendeley Web catalog
**Foreign language works**

Works in languages other than English should be given a tag of the following form: ‘L=[Language]’, e.g., ‘L=Mandarin’.

**Import via reference files**

The primary way you should import references to Mendeley is via reference files (e.g., .bib, .ris), downloaded from publishers’ websites. Reference files are text files containing the details (e.g., author(s), year etc.) of one or more publications in a specific format. Entire reference libraries can be exported into a single such file.

The easiest way to import the files to Mendeley Desktop by is by drag-and-drop. To do this, first select the Mendeley group or folder into which you want to import references in the left-hand panel (e.g., ‘WGI Chapter 1’) and to then drag-and-drop the file(s) onto the Documents tab in the central panel. Where available, please import BibTeX files (.bib), or in their absence on a publishers’ website, RIS files (.ris). If given the option, **download both the citation and the abstract**. This will assist the TSU as upon the publication of the AR6 WGI report, a set of reference files containing the details (including abstracts) of all the references cited will be made available online.

![Example of exporting a BibTeX reference file (.bib) from a journal website.](image)

In some cases, no reference files will be available, in which case the reference will either have to be added manually (see Manual entry below) or by dragging-and-dropping a PDF onto the Documents tab. Note that you can navigate to referencing files and PDFs on your local machine for import using the ‘Add Files’ and ‘Add Folder’ options in the Add references dropdown (#1) in Mendeley Desktop. The latter will import all the files from a local folder in one go.
**Import from other reference software**

To import references from other referencing software (e.g., EndNote), first export them from the software into a reference file format that Mendeley can import (e.g., .bib, .ris, EndNote XML), and then drag-and-drop the file that is generated onto the Documents tab.

**Import via PDFs**

References can be created from a PDF document by dragging-and-dropping the PDF onto the Documents tab in Mendeley Desktop. However, this approach frequently produces incorrect reference details (particularly if the reference is not already in Mendeley’s crowd-sourced database), so we thus recommend you import instead using reference files whenever possible. When you do use this approach, please check the details of, and remove the PDF attachment from, the reference entry that is generated. See the box on removing PDF attachments below.

**Direct import**

Some publishers provide the option of directly importing references to Mendeley from their website (see the examples below). Such options either import via a ‘Save documents to your Mendeley Library’ page or via a Mendeley Web Importer popup that will appear atop the publisher’s webpage. In both cases, you’ll first be asked to login to your Mendeley account if you are not already, and then be presented with a dropdown where you can select the folder or group to import to. If downloading to your chapter’s Mendeley group, untick the box next to ‘Download PDFs if available’ to stop any associated PDF from being imported along with the reference details.

Examples of ‘direct import to Mendeley’ buttons on journal websites
Manual entry

When necessary, references can also be added manually. To do this in Mendeley Desktop, open the dropdown on the Add references menu (#1), and then select ‘Add Entry Manually’. If you have a DOI for the reference, try entering this in the DOI field and clicking on the adjacent magnifying glass symbol to see if Mendeley can locate the reference and automatically populate the reference fields for you.

![Popup for manually adding references.](image)

If you do not have a DOI or the DOI could not be found, enter the reference details manually as follows:

- First select the appropriate Mendeley reference type in the Type dropdown (e.g., Journal Article) – see the Annex.

- Then insert details for each of the required fields and any additional optional fields (e.g., DOI, URL) that are available. Required and optional fields are listed in the Annex by IPCC reference type.

- Enter author names as ‘[Surname], [Initials]’ (e.g., ‘Surname, A.B.’) or ‘[First name(s)] [Surname]’. To enter additional author names, press the enter key to go down to a new line. Enter journal names in unabbreviated form (e.g., ‘Journal of Climate’ rather than ‘J. Clim.’).

Suggestions for author names and journals will appear as you type in the ‘Authors’ and ‘Journal’ fields. If you select a suggestion, check that it obeys the above formatting rules.
Removing PDF attachments and PDF links from references

PDF attachments can removed by selecting the reference in the Documents tab, and then scrolling down to ‘Files:’ in the Details panel and clicking the ‘x’ next to them.

In addition to PDF attachments, download links to PDFs can also appear under ‘Files:’ in the Details panel. These can also take up considerable storage space so also need to be removed.

Backing up Mendeley folders

The designated individual with overall responsibility for referencing for your chapter (usually a Chapter Scientist) should make frequent BibTeX backups of all the references in the chapter’s Mendeley group. The best way to do this is to use Mendeley’s built in ‘BibTeX Syncing’ function. This function is accessed via ‘Tools > Options > BibTeX’ and will update a single BibTeX file (containing all the references for your chapter group) each time you open Mendeley Desktop. You can periodically create backups of this file by creating folders titled with the current date and then copying and pasting this file into
them. You should use the settings shown in the below screenshot to create the BibTeX file, although with a different Path.

![Screenshot of BibTeX settings](image)

The settings to use to create BibTeX backups of your chapter's Mendeley group.

**Watch folders (only works with your Personal Library)**

Watch folders are folders on your local machine from which Mendeley automatically generates reference entries as new files are added to them. You cannot set up watch folders that import to group folders - import can only be to your personal 'All Documents' folder. Note that there is no two-way syncing between them and your 'All Documents' folder. The only operation performed is a one-way import as new files are added – if you delete files from the watch folder on your local machine, the corresponding references in 'All Documents' will not be removed. Similarly, if you delete references in 'All Documents' that were originally imported from a watch folder, the corresponding watch folder files will not be removed.

**Mendeley Citation Plugin for Word**

The Citation Plugin for Word allows you to insert in-text citations from your chapter’s Mendeley group and then generate a reference list of the unique citations. Although the plugin has a different appearance in the Mac and Windows versions of Word, the functionality is the same. In the Mac version, the plugin appears as a separate tool panel
and can be positioned anywhere you like. In the Windows version, the plugin is accessed via the References tab and is called the 'Mendeley Cite-O-Matic'.

Inserting in-text citations

In order to insert an in-text citation with the Mendeley Word plugin, the corresponding reference(s) must already be present in your chapter’s Mendeley group. You will then be able to search for the reference(s) by clicking on ‘Insert Citation’ on the citation plugin. In the search panel that appears, you can either search by typing in the search box (where it says ‘Search by author, title of year in My Library’), or by clicking ‘Go To Mendeley’ and selecting reference(s) in Mendeley Desktop. With the latter option, select the reference(s) in the Documents tab and then click on the ‘Cite’ button that temporarily appears in the upper panel.

Adding an in-text citation using the search box method.
Adding an in-text citation via the ‘Go To Mendeley’ method.

The resulting citation field in the Word document. Here the citation field has been made visible using grey shading (by default such shading is turned off in Word). See ‘Unlinked citations’ for how to do this.

You can add multiple citations in one go using the search box method by searching again within the search bar and selecting from the results that appear. If you are adding the last of a set of references, you will need to click on the reference you want to cite in the resulting list, as if this reference is already highlighted and you simply click ‘OK’, it will not include it in the citation. **When you identify incorrect author names and years in in-text citations, please correct the corresponding reference details in Mendeley.** If this citation has not been manually edited (see below for information), the year and author name will be updated in Word when you do a refresh with the Word plugin (a ‘reference refresh’).

**Adding or removing citations in a citation field**

To add additional in-text citations to a Mendeley citation simply place the cursor within the citation field in the document, which will cause the ‘Insert Citation’ button to change
to ‘Edit Citation’, and then click on the latter button to bring up the search bar. You will then be able to add more in-text citations using the method described above. This method only works for citations that have not been manually edited. **Note that sometimes you will need to put your cursor near the start or end of the citation field to make the button change to read ‘Edit Citation’.** You can delete citations within the search bar. You can’t, however, use this search bar to delete the entire citation field. To do this, select the entire field in the document and delete it with a backspace.

Adding an additional citation to a citation field

**If you find Word becomes slow when adding or editing in-text citations, try working on the citations in a blank Word document.** Mendeley citation fields can be copied and pasted within and between Word documents.

**Manually editing citations**

The Mendeley Word plugin is only designed to create citations of the following form ‘(Author, year)’ or ‘(Author, year; Author, year). Sometimes you will want to include the author as part of the sentence and thus have a citation of the form ‘Author (year)’. The only way to do this in the Mendeley Word plugin is to manually edit the citation (i.e., directly edit the text within the citation field). This is problematic as if the year or author name is subsequently found to be incorrect and is updated in Mendeley, the citation in Word will remain unchanged. The TSU has developed a Word macro to check for such issues, which will be supplied to the Chapter Scientists, so they can make manual
corrections. To streamline this process, we ask that if you manually edit a citation field in Word to ensure the author name and year remains within the field.

Mendeley creates in-text citations in this format: [Bjerknes, 1969]

But sometimes you will want to write citations in this format: Bjerknes (1969)

An example of manually editing a citation to so that the author name becomes part of the sentence.

The plugin does have the option of dropping author names from citations, leaving just the years written in the citation field (e.g. ‘(1969)’). This ‘Suppress author’ option is accessed by clicking on ‘Edit citation’ and then putting the cursor on the reference in the search bar. While it is thus possible to use this method to write ‘Bjerknes (1969)’ (by writing ‘Bjerknes ’ outside the citation field), this will mean that only ‘(1969)’ remains within the citation field, thus breaching our streamlining recommendation.

Options for editing an in-text citation. Please do not use the ‘Suppress author’ option shown here. The other options (adding a Prefix etc.) can be used, although are unlikely to be needed.
**Merging a citation**

If you want to merge two citation fields into one, highlight both and then click on the ‘Merge Citations’ button (which would have formerly read ‘Insert Citation’).

![Mendeley citation plugin interface](image)

Merging two citation fields.

**Unlinked citations**

One of the tasks of the person doing referencing quality control for your chapter will be to ensure that every in-text citation is ‘linked to Mendeley’ (i.e., was generated using the Mendeley Word plugin) and is not simply text (i.e. an ‘unlinked citation’). The former are embedded in Word files in the form of a field code. The content of a field code can be viewed by right clicking on it and selecting ‘Toggle field codes’.

Unlinked citations in Word drafts can be easily identified by setting field shading to ‘Always’ under ‘Options > Advanced options’, which will display grey shading over each Mendeley citation field. For example, “The IPCC was established in 1988 (Author X, 2018).” Unlinked citations will not be shaded.

**Refreshing the Word citations**

To refresh the citation fields in Word click on the ‘Refresh’ button in the Word plugin. This will connect to Mendeley Desktop and check/update as needed the details stored in the citation fields. We recommend doing a sync in Mendeley Desktop before doing this ‘reference refresh’, as if you haven’t synced for a while, the references in your chapter group in Mendeley Desktop might not be up-to-date.

**If when you do a reference refresh, one or more popups appear asking if you want to keep a manual citation edit, you should click ‘Keep Manual Edit’.** This will maintain manual edits that you or others have made to the Word citations.
**Missing references**

In the case that the Word plugin can't find the reference in Mendeley Desktop (e.g., if it was deleted), it will first search in the Trash. If it finds the reference there, it will also search for duplicates of the reference in your personal library.

**References found in the Trash**

If it finds the reference in the trash, the ‘Cited Documents in Trash’ window will appear showing you both this document and any duplicates it found in your personal library.

![Cited Documents in Trash](image)

The ‘Cited Documents in Trash’ popup, which will appear if the missing citation is found in the Trash.

**References not found in the Trash**

If it doesn't find the reference in the Trash (e.g., if it was permanently deleted), it will bring up the 'Import References?' window, asking where you would like to import the reference to. You should select ‘Shared Group’ and then the name of your chapter's group in the 'Import to:' dropdown. The plugin will then search for duplicates of the reference in this group. If it finds a non-identical duplicate, the ‘Duplicate Documents’ popup will appear and give you the option of either selecting the version of the reference as stored in the Word file (show in the 'New Documents to import' column), or the duplicate found in the group (in the 'Existing documents to use' column). If it is the right reference, you should select the latter to avoid creating a duplicate.
If it does not find the duplicate at all or finds an identical duplicate, the ‘Duplicate Documents’ popup will not appear and the reference will be automatically regenerated in the group from the details in the Word file.

The ‘Import References?’ popup, which will appear if the reference is not found in the Trash.

The ‘Duplicate Documents’ popup.

**Generating the bibliography**

To generate a reference list, place the cursor where you want this to appear (typically at the end of the chapter) and select ‘Insert Bibliography’ on the Word plugin. Once created, the bibliography will be automatically updated as in-text citations are added or edited.
Removing duplicates

Mendeley Desktop has an option to identify duplicates in a group or folder, although it may not identify all duplicates. To use this facility, select the group or folder in the left hand panel and then select ‘Tools > Check for Duplicates’. Once the number of references in your Mendeley group becomes substantial, however, you may not want to use this method as many of the references identified as having duplicates may not be cited in the latest draft (so it would be unnecessary to merge them). Alternatively, you can manually identify duplicates for removal, select them and then click ‘Merge Documents’ in the Details panel to bring up the merge options.

Manually selecting duplicates

To select two or more references that are consecutive in the Documents panel, use the Shift button. To select references that are not consecutive, use the Ctrl button.

Merging duplicates

The merge process is the same whether you identified the duplicates manually or using the in-built facility. The central Documents tab will show a merged version of the references (top line), together with the references themselves (second line onwards). Note that you can expand and hide the references to be merged by clicking the arrow at the left of the top line. The top line is what will the references will be replaced with when ‘Confirm Merge’ is clicked. The Details panel with state that either the references to be merged are non-identical (‘Duplicates have conflicting fields’, i.e. one or more fields differ) or that they are identical (‘No conflicting fields’). Note that if you realise you’ve selected references that are not duplicates, just click ‘Close’ in the Documents tab to exit the merge process.
**No conflicting fields**

If the duplicates do not conflict, you can go straight ahead and click ‘Confirm Merge’ to merge the duplicates.

In this example there are no conflicting fields, so you can go straight ahead and select ‘Confirm Merge’ to merge the references.

**Duplicates have conflicting fields**

In the case that there are one or more fields that conflict, you will need to decide what the entries for these fields should be. The conflicting fields are those without ticks next to them in the Detail panel in the merged version. The bars on the right hand side in the Documents tab measure the similarity between the duplicates and their merged version. Mendeley automatically fills the conflicting fields with an entry from one of the references, or a concatenation of all the unique entries.

To alter the merged version of a conflicting field with a version from one of the duplicates, place a tick next to the version you want to use. This will cause a tick to be placed next to this field in the merged version, indicating that the conflict has been dealt with. Note that it is acceptable for the ‘Citation Key:’ field to be in conflict. You can use any version of this field in the merged reference (we do not need this field).

Once you’re happy with the merged version of the duplicates, click ‘Confirm Merge’. This will cause the duplicates to be sent to the Trash and the merged version to replace them in your Mendeley group. You are not yet finished, however. For reasons explained below, it is **important that you go to the Trash and permanently delete the duplicates.** The easiest way to do this is to simply empty the Trash.
In this example the ‘Pages’ fields conflict, as indicated by the lack of a tick mark next to this entry in the merged version. In this case, Mendeley has filled this field with the version from the first of the selected references (note that the bar is at 100% for this reference, while is slightly below 100% for the reference below).

**Problematic duplicate removal**

Sometimes, doing a reference refresh in Word will cause duplicates to be reintroduced to your Mendeley group. For instance, this will occur if the missing reference currently resides in your Trash, with a copy also in the Mendeley group. In this case, Mendeley will search in your personal library for the reference, but not in the Mendeley group (and so won’t detect that the reference already exists there), and you will have no choice but to reintroduce the reference to the group, thus creating a duplicate.

If, however, you emptied the Trash after removing the duplicates, Mendeley will not find the reference there and will instead ask you to select a folder or group to import the reference to (see the section on ‘Checking citation links’). It will then do a search in this folder or group, where in the ideal case it will detect a match such that you can then select to use this existing version in the ‘Duplicate Documents’ popup (and thus not create a duplicate). If, however, it does not detect a match, a duplicate will be introduced. Mendeley does not have very sophisticated duplicate detection - only small differences between fields can cause it not to detect a match.

These are the steps to take in the event that no match is found, when one should have been:

1) First make all the fields of the duplicates identical. A quick way to do this is to assuming you have a DOI is to, one duplicate at a time, ‘search by DOI’ within the Details Panel (click on the magnifying glass next to the DOI). This will search Mendeley's crowd-sourced database for this DOI and then overwrite all the fields with what it finds.

2) Next do a reference refresh on the Word document to copy these new details into the corresponding Mendeley citation fields in the Word drafts.
3) Now merge the duplicates in Mendeley Desktop (the duplicates will not be conflicting, so this should be straightforward). Be sure to permanently delete duplicates after they’re sent to the Trash.

4) Finally, do another reference refresh on the Word document. This time, after you select the group in the ‘Import References?’ popup, Mendeley should detect a match, which you should then select to use in the ‘Duplicate Documents’ popup. Thus a duplicate will not be created.

**Citation styles**

The WGI TSU is currently developing an IPCC citation style (‘IPCC AR6 WGI’) for use with the Word plugin. Citation styles control both the style of in-text citations and of bibliographies. Unfortunately, this style will only be able to format in-text citations in correct IPCC style and not bibliographies. The TSU will take care of the correct formatting of bibliographies using its own software (although we still ask chapter teams to provide the bibliography as formatted by the ‘IPCC AR6 WGI’ style).

Until the IPCC citation style is available, please use the *Frontiers journals* style. You can obtain this style in the Word plugin by clicking on ‘More Styles…’ at the bottom of the Style dropdown menu and then searching and downloading it from the ‘Get More Styles’ tab. Once installed, you will be able to select the style from the Style dropdown. Once released, you will be able to obtain the IPCC citation style in the same manner.

The ‘Get More Styles’ tab on the ‘Citation Styles’ menu from where you can install the ‘Frontiers journals’ style.
Mendeley Web

The online version of Mendeley (mendeley.com), Mendeley Web, can perform the same basic operations as Mendeley Desktop (e.g., viewing and adding references). Mendeley Web also has social networking capabilities (e.g., messaging and following other researchers), but these are beyond the scope of this guide. We direct you to the official guide for information on these. The following are the most relevant features within the context of writing an IPCC report, including the Web Library and Groups pages.

The layout of Mendeley Web.

1. **Feed** – This will show you a feed of the publications added to your chapter’s Mendeley group, along with article suggestions from Mendeley.

2. **Library** – Web Library.

3. **Suggest** – Suggests articles Mendeley thinks you may be interested in based on the content of your library.

4. **Groups** – You can view information about your chapter’s shared group here (and add or remove members if you are a CLA).
5. **Search** – Search for papers, people or groups here. By selecting papers as the search criteria, it will be search Mendeley’s crowd-sourced catalogue.

6. **Settings** – Use this dropdown to access the settings for, or log out of, your Mendeley account.

### Web Library

The layout and functionality of Web Library is similar to that the Mendeley Desktop, so we will not go over it in detail here. One difference from the Desktop application is that it automatically syncs each time you make a change.

![Web Library](image)

The layout of Web Library. As in Mendeley Desktop, you can view, add/remove and edit references.

To import references, select the destination group or folder in the left-hand panel, and drag and drop reference files (e.g., .bib) onto the central panel. Alternatively, you can use the options under the blue ‘Add’ button to do the same thing, which also has an
option for manually entering a new reference. As in Mendeley Desktop, you can drag and drop references between groups and folders in Web Library.

**Groups**

By clicking on Groups in the navigation panel of Mendeley Web you will be taken to your ‘My Groups’ page, where you can access information about your chapter’s Mendeley group.

While the WGI TSU will be shown as the group owner, CLAs will have admin access, enabling them to control group membership. To invite someone join the group, CLAs can click on ‘Invite members’ and enter the person’s email. They can also remove an existing group member from the Members page (click on Edit next to the person’s name and then select ‘Remove from group’). You can also do these actions from the Members tab in the central panel of Mendeley Desktop.

CLAs can invite people to join the group by clicking ‘Invite members’ and entering their email.

Changing the status of a group member. Only CLAs will be able to see these options.

The TSU will keep track of the cloud storage usage of your group (100MB is the storage limit). PDFs attached to references should be deleted to free up space.
Mendeley Web Importer

Although we strongly discourage the use of Mendeley Web Importer as it can frequently result in the import of incorrect reference details, we provide guidance on its usage here for completeness. Mendeley Web Importer is a browser plugin that scans your current browser window to generate a reference. Versions are available for Chrome, Firefox, Internet Explorer and Safari [here](#). The Chrome and Firefox versions install like any other plugin in those browsers. The Safari and Internet Explorer versions are installed by dragging a ‘Save to Mendeley’ button onto the bookmarks/favorites bar.

If the bookmarks/favorites bar is not visible in your browser, you will need to display it. In Internet Explorer 10, right click on the bar at the top of the screen, to the right of any open tabs and select ‘Favorites bar’. To show a hidden favorites bar in Safari, select ‘View > Show Favorites Bar’.

![Mendeley Importer](image)

Installing Mendeley Web Importer for Chrome.

![The Web Importer button in Chrome.](image)
Installing Web Importer for Safari/Internet Explorer. Once you have made bookmarks/favorites bar visible, drag the red ‘Save to Mendeley’ button onto it.

The ‘Save to Mendeley’ button on the favorites bar in Internet Explorer.

Pulling references details from a journal webpage using the Web Importer. Note that the details the plug has found would need to be edited in this case (the article name is in all capitals, and the author name has been repeated twice). **This is a good example of why we strongly discourage the use of the Web Importer plugin.**
To use Web Importer, either navigate to the webpage for the reference or open the PDF of a reference in your browser, and then click on the Web Importer browser button. In the window that appears, select the folder to which you like to import the reference (e.g., ‘WGI Chapter 1’). If downloading to your chapter’s group uncheck the ‘Download PDFs if available’ box to stop any corresponding PDF from downloading. Finally and most importantly, check the reference details are correct, editing them if necessary before pressing ‘Save’.

Annex: IPCC Reference Types

This annex lists the IPCC Reference Types that have been defined by the TSU, and their corresponding reference type codes or rt codes. The TSU will add the latter in the Tags and Translators fields in Mendeley. In addition, the tables indicate the Mendeley reference type that should be used with each type (select this in the Type field dropdown). It lists the fields that should always have entries (‘required fields’) for a given reference type, and those that will sometimes be empty due to absence of the information (‘optional fields’ – complete where possible). Note that a lowercase ‘r’ should be used for the reference type codes in the Tags field (e.g., ‘rt6’) while an uppercase ‘r’ should be used in the Translators field (e.g., ‘Rt6’).

### Journal articles

<table>
<thead>
<tr>
<th>Reference type</th>
<th>Mendeley type</th>
<th>Code in Tags field</th>
<th>Code in Translator field</th>
<th>Text in Volume field</th>
<th>Required fields</th>
<th>Optional fields (complete where possible)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal article (Published)</td>
<td>Journal Article</td>
<td>[None]</td>
<td>[None]</td>
<td></td>
<td>Title Authors Journal Year</td>
<td>Volume Issue Pages DOI</td>
</tr>
<tr>
<td>Journal article (in preparation – i.e., not yet submitted)</td>
<td>Journal Article</td>
<td>(in prep)</td>
<td>[None]</td>
<td>(in prep)</td>
<td>Title Authors</td>
<td>Journal</td>
</tr>
<tr>
<td>Journal article (submitted)</td>
<td>Journal Article</td>
<td>(submitted)</td>
<td>[None]</td>
<td>(submitted)</td>
<td>Title Authors Journal</td>
<td>Volume Issue Pages DOI</td>
</tr>
<tr>
<td>Journal article (in press – i.e. accepted but not yet formally published)</td>
<td>Journal Article</td>
<td>(in press)</td>
<td></td>
<td></td>
<td>Title Authors Journal Year</td>
<td>Volume Issue Pages DOI</td>
</tr>
</tbody>
</table>
### Books, reports, working papers and theses

<table>
<thead>
<tr>
<th>Reference type</th>
<th>Mendeley type</th>
<th>Rt Code (Tags field)</th>
<th>Rt Code (Translators field)</th>
<th>Required fields</th>
<th>Optional fields (complete where possible)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Book (unedited)</td>
<td>Book</td>
<td>rt4</td>
<td>Rt4</td>
<td>Title, Authors, Year, Pages (page count), City (City + Country of Publisher), Publisher</td>
<td>Series (Book series) URL DOI</td>
</tr>
<tr>
<td>Edited book or report</td>
<td>Book</td>
<td>rt5</td>
<td>Rt5</td>
<td>Title, Year, Pages (page count), City (City + Country of Publisher), Editors, Publisher (for report: Publisher and/or Institution)</td>
<td>Series (Book series for a book or Report number for a report) URL DOI</td>
</tr>
<tr>
<td>Chapter in Edited Book or Report</td>
<td>Book section</td>
<td>rt6</td>
<td>Rt6</td>
<td>Title (of chapter), Authors, Book, Year, Pages (page range), City (City + Country of Publisher), Editors, Publisher (for report: Publisher and/or Institution)</td>
<td>Series (Book series for a book or Report number for a report) URL DOI</td>
</tr>
<tr>
<td>Chapter in Unedited Book or Report</td>
<td>Book section</td>
<td>rt14</td>
<td>Rt14</td>
<td>Title (of chapter), Authors, Book, Year, Pages (page range), City (City + Country of Publisher), Publisher (for report: Publisher and/or Institution)</td>
<td>Series (Book series for a book or Report number for a report) URL DOI</td>
</tr>
<tr>
<td>Report (unedited)</td>
<td>Report</td>
<td>rt7</td>
<td>Rt7</td>
<td>Title, Authors, Year, Pages (page count), City (City + Country of Publisher), Publisher (Publisher and/or Institution)</td>
<td>Series (Report number) URL DOI</td>
</tr>
<tr>
<td>Working paper (unedited)</td>
<td>Working paper</td>
<td>rt18</td>
<td>Rt18</td>
<td>Title, Authors, Year, Pages (page count), City (City + Country of Publisher), Publisher (Publisher and/or Institution)</td>
<td>Series (Working paper number) URL DOI</td>
</tr>
<tr>
<td>Working paper (edited)</td>
<td>Working paper</td>
<td>rt24</td>
<td>Rt24</td>
<td>Title, Year, Pages (page count), City (City + Country of Publisher), Editors, Publisher (Publisher and/or Institution)</td>
<td>Series (Working paper number) DOI URL</td>
</tr>
<tr>
<td>Thesis (e.g. PhD or MSc)</td>
<td>Thesis</td>
<td>rt10</td>
<td>Rt10</td>
<td>Title, Authors, Year, Pages (page count), City (City + Country of University), Department, University, Type (of Thesis, e.g., ‘PhD’)</td>
<td>DOI URL</td>
</tr>
</tbody>
</table>
### Web-based materials

<table>
<thead>
<tr>
<th>Reference type</th>
<th>Mendeley type</th>
<th>Code (Tags field)</th>
<th>Code (Translators field)</th>
<th>Required fields</th>
<th>Optional fields (complete where possible)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web page</td>
<td>Web page</td>
<td>rt11</td>
<td>Rt11</td>
<td>Title, Authors (e.g., Institution), Year, Date Accessed, URL</td>
<td></td>
</tr>
<tr>
<td>Online database</td>
<td>Web page</td>
<td>rt17</td>
<td>Rt17</td>
<td>Title, Authors (e.g., Institution), Year, Date Accessed, URL</td>
<td></td>
</tr>
</tbody>
</table>

### Conference or workshop proceedings

<table>
<thead>
<tr>
<th>Reference type</th>
<th>Mendeley type</th>
<th>Code (Tags field)</th>
<th>Code (Translators field)</th>
<th>Required fields</th>
<th>Optional fields (complete where possible)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conference or workshop proceedings (unedited)</td>
<td>Book</td>
<td>rt8</td>
<td>Rt8</td>
<td>Title, Authors, Year, Pages (page count), City (City + Country of Publisher), Publisher</td>
<td>DOI</td>
</tr>
<tr>
<td>In proceedings (unedited)</td>
<td>Conference proceedings</td>
<td>rt9</td>
<td>Rt9</td>
<td>Title, Authors, Year, Pages (page range), Proceedings Title, City (City + Country of Publisher), Publisher</td>
<td>DOI</td>
</tr>
<tr>
<td>Conference or workshop proceedings (edited)</td>
<td>Book</td>
<td>rt25</td>
<td>Rt25</td>
<td>Title, Year, Pages (page count), City (City + Country of Publisher), Editors, Publisher</td>
<td>DOI</td>
</tr>
<tr>
<td>In proceedings (edited)</td>
<td>Conference proceedings</td>
<td>rt26</td>
<td>Rt26</td>
<td>Title, Authors, Proceedings Title, Year, Pages (page range), City (City + Country of Publisher), Editors, Publisher</td>
<td>DOI</td>
</tr>
</tbody>
</table>
### IPCC documents

<table>
<thead>
<tr>
<th>Reference type</th>
<th>Mendeley type</th>
<th>Code (Tags field)</th>
<th>Code (Translators field)</th>
<th>Required fields</th>
<th>Optional fields (complete where possible)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entire IPCC report (including Special Reports and Workshop Reports)</td>
<td>Report</td>
<td>rt12</td>
<td>Rt12</td>
<td>Title, Authors, Year, Pages (page count), Publisher, Editors, City (City + Country of Publisher)</td>
<td></td>
</tr>
<tr>
<td>Chapter within IPCC report</td>
<td>Book section</td>
<td>rt13</td>
<td>Rt13</td>
<td>Title, Authors, Year, Pages (page range), Book (Report title), City (City + Country of Publisher), Editors, Publisher</td>
<td></td>
</tr>
<tr>
<td>IPCC Guidance note</td>
<td>Report</td>
<td>rt15</td>
<td>rt15</td>
<td>Title, Authors, Year, Pages (page count), Publisher, City (City + Country of Publisher)</td>
<td></td>
</tr>
</tbody>
</table>

### Other types

<table>
<thead>
<tr>
<th>Reference type</th>
<th>Mendeley type</th>
<th>Code (Tags field)</th>
<th>Code (Translators field)</th>
<th>Required Mendeley fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encyclopedia article</td>
<td>Encyclopedia Article</td>
<td>rt23</td>
<td>Rt23</td>
<td>Title, Authors, Year, Pages, Encyclopedia, City (City + Country of Publisher), Publisher, Editors, DOI</td>
</tr>
<tr>
<td>Magazine article</td>
<td>Magazine Article</td>
<td>rt20</td>
<td>Rt20</td>
<td>Title, Authors, Year, Publication (Name of Magazine), City (City + Country of Publisher), Publisher, Volume, Issue, Pages (page range), DOI</td>
</tr>
<tr>
<td>Newspaper article</td>
<td>Newspaper Article</td>
<td>rt21</td>
<td>Rt21</td>
<td>Title, Authors, Year Publication (Name of Newspaper), City (City + Country of Publisher), Publisher, Volume, Issue, Pages (page range), DOI</td>
</tr>
<tr>
<td>Video recording</td>
<td>Television Broadcast</td>
<td>rt27</td>
<td>Rt27</td>
<td>Title, Directors (can enter Performers if applicable), Year, City (City + Country of Distributor), Distributor, City (City + Country of Publisher), Publisher, DOI</td>
</tr>
<tr>
<td>Legal hearing</td>
<td>Hearing</td>
<td>rt22</td>
<td>Rt22</td>
<td>Title, Authors (e.g., Company vs Country), DOI</td>
</tr>
</tbody>
</table>

Note: This table is mainly provided for completeness. Careful regard to the IPCC guidelines on the use of literature may be warranted when considering to cite literature of some of these types.